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Introduction
The Cisco CRS platform provides a multimedia (voice, data, and web), IP-enabled 
customer-care application environment that enhances the efficiency of contact 
centers by simplifying business integration, easing agent administration, 
increasing agent flexibility, and enhancing network hosting.

Cisco CRS 4.0(5)

Cisco CRS 4.0(5) provides resolutions to important issues enhancements to the 
3.x to 4.0(5) upgrade procedures. It also provides these updated documents:

 • Cisco CRS Installation Guide 4.0(5)

 • Cisco CRS Servicing and Troubleshooting Guide 4.0(5)
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 • Cisco IPCC Express Edition Solution Reference Network Design

 • Cisco CAD Service Information 6.1

You can access these updated documents at this URL:

http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/ 
tsd_products_support_series_home.html

Cisco CRS 4.0(4)

Cisco CRS 4.0(4) provides resolutions to important issues. It also provides 
support for Citrix, and these updated documents:

 • Cisco IPCC Express Edition Solution Reference Network Design

 • Cisco CRS Installation Guide 4.0(5)

Cisco CRS 4.0(3)

Cisco CRS 4.0(3) provides resolutions to important issues. It also provides:

 • Embedded browser for the Cisco Agent Desktop

 • Cisco IP Phone Agent support for these Cisco IP Phone models:

 – Cisco IP Phone 7911

 – Cisco IP Phone 7920 (for additional information about using this phone 
model, refer to Cisco IPCC Express 4.0 Solution Reference Network 
Design (SRND)

 – Cisco IP Phone 7941

 – Cisco IP Phone 7961

 • Cisco Agent Desktop and Cisco Supervisor Desktop support for these 
Cisco IP Phone models:

 – Cisco IP Phone 7911

 – Cisco IP Phone 7920 (for additional information about using this phone 
model, refer to Cisco IPCC Express 4.0 Solution Reference Network 
Design (SRND)

 – Cisco IP Phone 7941

 – Cisco IP Phone 7961

 – Cisco IP Phone 7985
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 • The following updated documents:

 – Cisco CAD Installation Guide 6.1(1)

 – Cisco CAD Service Information 6.1(1)

 – Cisco Agent Desktop User's Guide 6.1(1)

 – Cisco Desktop Administrator User's Guide 6.1(1)

 – Cisco IP Phone Agent User's Guide 6.1(1)

 – Cisco Supervisor Desktop User's Guide 6.1(1)

 – Cisco CRS Servicing and Troubleshooting Guide 4.0(1)

 – Cisco IPCC Express 4.0 Solution Reference Network Design (SRND)

 – Cisco CRS Installation Guide 4.0(5)

Cisco CRS 4.0(2)

Cisco CRS 4.0(2) provides resolutions to important issues.

Cisco CRS 4.0(1)

Cisco CRS 4.0(1) provides a variety of new and enhanced features, including:

 • Cluster-based architecture

 • Enhanced installation procedure

 • Enhanced administration and serviceability

 • Optional high availability with automatic failover

 • Increased maximum number of agents to 300

 • Integration into Cisco Customer Interaction Network

 • New ACD routing and related features

 • Support for Cisco IP Phone 7970

 • Support for Cisco Communicator

 • Enhancements to the look and feel of the Cisco Agent Desktop and the 
Cisco Supervisor Desktop

 • New and enhanced historical reports

 • New automatic speech recognition (ASR) and text-to-speech (TTS) model
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Installation, Upgrade, and Patching Notes
This section includes these topics:

 • Running the Pre-Upgrade Check Tool when Upgrading to Cisco CRS 4.0(x), 
page 6

 • Upgrading from CRS 3.x when CTI Ports Belong to More than One Device 
Pool, page 7

 • Correcting CRS 3.x to Cisco CRS 4.0(5) Upgrade Error Caused by 
Incomplete Uninstallation of CRS 3.x, page 6

 • Upgrading Microsoft SQL Server 2000, page 7

 • Installing a Patch on a Coresident Server, page 7

 • Hyperthreading Not Supported, page 8

Running the Pre-Upgrade Check Tool when Upgrading to Cisco 
CRS 4.0(x) 

The Cisco CRS 4.0(5) Installation Guide describes where to obtain the Cisco CRS 
4.0 Pre-Upgrade check tool and when to use this tool. To run tool, follow these 
steps:

1. Download the tool to the server on which the Cisco CRS Engine is installed.

2. Launch the .exe file that you download and wait until it completes the 
extraction of the files and launches the tool.

3. When the tool starts, follow the on-screen instructions.

Correcting CRS 3.x to Cisco CRS 4.0(5) Upgrade Error Caused by 
Incomplete Uninstallation of CRS 3.x

If you encounter an error when upgrading from Cisco CRS 3.x to CRS 4.0(5) and 
you determine that the error was caused by an incomplete uninstallation of the 3.x 
software (because, for example, you omitted an upgrade step or provided an 
incorrect response to a prompt), perform the following steps. This procedure 
assumes that you have successfully performed Step 1 through Step 16 in the 
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“Upgrading the Cisco CRS Software” section in the “Upgrading Cisco CRS 3.x 
to Cisco CRS 4.0(5)” chapter in Cisco Customer Response Solutions 4.0(5) 
Installation Guide. In this case, you should have a backup file that is saved in a 
location other than the CRS server.

4. On the CRS server that is having the upgrade problem, re-install the operating 
system and re-image the operating system partitions.

5. Configure the re-imaged server with the same host name and IP address that 
it had originally.

6. Follow the procedure in “Replacing the Cisco CRS Server” section in the 
“Upgrading the Cisco CRS Software”, starting from Step 2.

Upgrading from CRS 3.x when CTI Ports Belong to More than One 
Device Pool

If you are upgrading from Cisco CRS 3.x and the CTI ports in any CTI port group 
belong to more than one device pool, make sure to add all of the device pools in 
the CRS 4.0(5) Data Migration page during the upgrade procedure.

Upgrading Microsoft SQL Server 2000
If you are using Microsoft SQL Server 2000, you must use the disk provided by 
Cisco to upgrade to the current version of this application when you upgrade to 
Cisco CRS 4.0(5). For instructions, see the MS SQL Server 2000 for 
Cisco Customer Response Solutions Resources Card.

Installing a Patch on a Coresident Server
After installing a patch on a coresident server (a server on which both Cisco CRS 
and Cisco CallManager are installed), you may see a “Patch” error message when 
starting the Cisco CRS Administration application. To avoid this issue, after you 
complete the patching procedure, rerun the BARS and restore the patch file again.
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Hyperthreading Not Supported
Hyperthreading is not supported by Microsoft Windows 2000 and 2003 and is 
disabled by default in Cisco-provided operating systems.

Related Documentation
Table 1 provides references to related documentation. In addition, you can obtain 
online help from the Cisco CRS Administration web pages, the Cisco CRS Editor, 
the Cisco Agent Desktop, the Cisco Supervisor Desktop, the 
Cisco Desktop Administrator, and the Cisco CRS Historical Reports client 
interface.

Note If a Cisco CRS document is not updated from a previous release of Cisco CRS, 
that document remains valid for the current release.

Table 1 Related Documentation 

Related Information and Software Document or URL

Cisco CRS documentation overview Cisco Customer Response Applications 4.0 
Resources Card in your Cisco CRS product package

Cisco CRS documentation http://www.cisco.com/en/US/products/sw/custcosw/
ps1846/tsd_products_support_series_home.html

Cisco Customer Response Solutions (CRS) 
Software and Hardware Compatibility Guide

http://www.cisco.com/en/US/products/sw/custcosw/
ps1846/products_device_support_tables_list.html

Voice and Unified Communications 
information

http://www.cisco.com/en/US/products/sw/voicesw/i
ndex.html

Operating system documentation http://www.cisco.com/en/US/products/hw/voiceapp/
ps378/prod_installation_guides_list.html

Cisco MCS hardware specifications http://www.cisco.com/en/US/products/hw/ 
voiceapp/ps378/products_data_sheets_list.html

Cisco CallManager Compatibility Matrix http://www.cisco.com/en/US/products/sw/voicesw/ 
ps556/prod_software_versions_comparison.html
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Important Notes
This section provides important information that might have been unavailable 
upon the initial release of documentation for Cisco CRS 4.0(5).

 • Upgrading Cisco CRS when cluster profile name is longer than 20 
characters—If you are upgrading to Cisco CRS 4.0(5) and the cluster profile 
name is longer than 20 characters, an error message appears. (You can 
determine the cluster profile name from the Cisco CRS Administration 
application by choosing System > LDAP Information and looking at the 
Profile Name field.) To workaround this issue:

 – If you are upgrading from Cisco CRS 3.x to 4.0(5), change the cluster 
profile name to be 20 characters or less.

 – If you are upgrading from Cisco CRS 4.0(x) to 4.0(5), perform the 
upgrade using Cisco CRS 4.0(5a), which will be available beginning on 
February 9, 2007.

 • Supported products—For current information about supported products for 
Cisco CRS, refer to Cisco Customer Response Solutions (CRS) Software and 
Hardware Compatibility Guide, which is available at this URL:

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device
_support_tables_list.html

Cisco CallManager documentation http://www.cisco.com/en/US/products/sw/voicesw/p
s556/tsd_products_support_series_home.html

Backup and restore documentation http://www.cisco.com/en/US/products/sw/voicesw/ 
ps556/prod_maintenance_guides_list.html

Service releases http://www.cisco.com/kobayashi/sw-center/sw-voice 
.shtml

Cisco Unified Contact Center Enterprise 
documentation 

http://www.cisco.com/en/US/products/sw/custcosw/
ps1844/tsd_products_support_series_home.html 

Cisco Unified Intelligent Contact Management 
Enterprise documentation

http://www.cisco.com/en/US/products/sw/custcosw/
ps1001/tsd_products_support_series_home.html

Table 1 Related Documentation (continued)

Related Information and Software Document or URL
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 • Creating Custom Historical Reports for Cisco CRS 4.0(5) SR1 with ES9, 
Cisco CRS 4.0(5) SR2 or later—Cisco CRS 4.0(5) SR1 with ES9, Cisco 
CRS 4.0(5) SR2 or later ship with the same version of Crystal Reports DLLs 
as in Cisco CRS 5.0(1). Hence, the process to create custom reports is also 
the same as in Cisco CRS 5.0(1). For detailed information on creating a 
report, refer to Cisco Customer Response Solutions 5.0(1) Historical 
Reporting Administrator and Developer Guide available at this URL:

http://www.cisco.com/en/US/docs/voice_ip_comm/cust_contact/contact_ce
nter/crs/express_5_0/programming/hr_admin_devp/crs501hd.pdf

 • Upgrading Client Applications when Upgrading Cisco CRS—When you 
upgrade from Cisco CRS 3.x to Cisco CRS 4.0(5), you also must upgrade 
Cisco Agent Desktop, Cisco Supervisor Desktop, and Cisco CRS Historical 
Reporting applications, if you are using these applications. To do so, you 
must have administrator privileges that allow you to install applications and 
suspend virus and intrusion detection software on the servers on which these 
applications are running. For additional information, refer to Cisco CAD 
Installation Guide and to Cisco Customer Response Historical Reports User 
Guide.

 • Third-party software might affect performance and support—Adding 
third-party software to a Cisco CRS system may affect how Cisco CRS 
functions and may affect Cisco’s support for Cisco CRS. Such third-party 
software includes Microsoft critical security updates, anti-virus software, and 
other non-required third-party software. Also, make sure to read and accept 
the license agreement that comes with a third-party product. For information 
about Cisco’s policy regarding third-party software, refer to this URL:

http://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_bulletins_list.
html

 • Active Directory integration might affect performance—If you are 
integrating Cisco CRS with Active Directory, refer to the caveat CSCsb20774 
for details about how you might be affected and for workarounds. To access 
this caveat, see the “Using Bug Toolkit” section on page 32.
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 • Deployment on MCS-7835-I1, MCS-7845-I1, or IBM xSeries-346 
server—If you are deploying an MCS-7835-I1, MCS-7845-I1, or IBM 
xSeries-346 server, refer to the field notice Some Cisco Media Convergence 
Server (MCS) Encounter Network Interface Card (NIC) Numbering Reversal, 
which is available at this URL:

http://www.cisco.com/en/US/products/hw/voiceapp/ps378/ 
products_field_notice09186a0080415411.shtml

 • Policy Changes in New Zealand Daylight Savings Time—To know about 
the policy changes in New Zealand daylight savings time and to understand 
the impact on Unified CCX, refer to the field notice FN - 62880 - New Zealand 
Daylight Savings Time Policy Changes Effective September 2007 - For Cisco 
Unified Contact Center Express (Unified CCX), which is available at this URL:

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_field_
notice09186a00808b40b7.shtml

 • Moving a node to another subnet might affect performance—If you move 
Cisco CRS nodes to another subnet, you may experience the following issues:

 – You cannot configure resource, skills, and so on

 – The MADM error log contains the message [Microsoft][ODBC SQL 
Server Driver][SQL Server][OLE/DB provider returned message: 

New transaction cannot enlist in the specified transaction 

coordinator.]

To work around this situation, check network connectivity, and add names to 
the hosts file.

 • Requirements for location of Cisco CRS Engine and Database 
components—The Cisco CRS Engine and Database components, in 
deployments with or without high availability,must be located in the same 
campus LAN and the round-trip delay between these servers should be less than 
2 ms. The links between these servers must be highly available and the available 
bandwidth should always be considerably higher than the load, and there should 
be no steady-state congestion.

 • HA Licensing Requirements

Note You need a WARM STANDBY license to enable the standby server.
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When you apply the licenses to the first or active node in the cluster, the 
license files get uploaded to the LDAP server in the central repository. The 
license configuration applies to the cluster, that is, to all machines in the 
cluster. This implies that if you have uploaded the WARM STANDBY license 
to the repository, then when you add a standby server to the cluster, it would 
use the same profile or repository to get the license files and you do not need 
to apply the same license files again to the standby server.

Note There is no separate license required for expansion server. However, the 
Recording and Monitoring services are enabled only with the ENH and 
PRE licenses.

If your license has HA capability, then the license file will contain a 
WARM_STBY feature line in it. For example, for Premium Servers, it would 
be CRS_EXP_PRE_WARM_STBY.

 • Redirection to translation patterns not supported—CRS does not support 
the use of consult transfer/redirect step from scripts to a translation pattern 
that maps back to a route point.

 • Password aging restrictions—Password aging is a Microsoft Active 
Directory feature that you can enable when Cisco CallManager is integrated 
with Active Directory. Do not enable this feature for any of the “system” 
Cisco CallManager user accounts, including the JTAPI provider user, the 
RMJTAPI provider user, or the telecaster user that is associated with the 
Cisco Desktop IP Phone Agent service. If you enable this feature but do not 
change the password for one of these Cisco CallManager users before the 
password expires, the following issues will occur: 

 – JTAPI provider user—Calls to Cisco CRS route points will not be 
processed

 – RMJTAPI provider user—Agents will not be able to login to the 
Cisco Agent Desktop or the Cisco IP Phone Agent

 – Cisco IP Phone Agent user—Agents will be unable to use the 
Cisco IP Phone Agent

 • Scheduled historical reports might not run when using a proxy 
service—If you are using a proxy service in Internet Explorer on the CRS 
Historical Reports client system, scheduled historical reports might not run 
and you might see this message in the CiscoSch.log file: [CRA_DATABASE] 
entry not found in the properties file followed by failed to 
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validate user OR get MaxConnections of database value. If this 
situation occurs but you can run the report directly from the CRS Historical 
Reports client system, follow these steps:

a. From Internet Explorer on the Historical Reports client system, choose 
Tools > Internet Options.

b. Click Connections.

c. Click LAN Settings.

The Use a Proxy Service check box will be checked if you are using a 
proxy server.

d. Click Advanced.

e. In the Do not use proxy server for addresses beginning with field, enter 
the IP address of the Cisco CRS server that the Historical Reports client 
system logs in to.

f. Click OK as needed to save your changes.

 • “Administrator” is required Windows account username—The only 
supported username for the Windows account on a server that is running 
Cisco CRS is Administrator. If you use another user name, the 
CRSAdminUtil.exe tool might not work properly.

 • Microsoft DTC requirements—The Microsoft Distribution Transaction 
Coordinator (DTC) requires that your system be able to resolve computer 
names by NetBIOS or DNS. You can test whether NetBIOS can resolve the 
names by using ping and the server name. The client computer must be able 
to resolve the name of the server and the server must be able to resolve the 
name of the client. If NetBIOS cannot resolve the names, you can add entries 
to the LMHOSTS files on the computers.

For additional information, refer to article number 250367 in the Microsoft 
online help and support knowledge base.

 • Cisco CallManager hardening procedure causes Cisco CRS 
configuration failure—CRS configuration fails if you perform the Cisco 
CallManager operating system hardening procedure using the scripts 
provided in the C:\utils\SecurityTemplate folder. This situation occurs 
because the scripts disable IIS and Tomcat services on Cisco CallManager 
subscribers, which affects the subscribers on which CTIManager is running. 
(These subscribers are designated by the IP address input for the JTAPI 
provider.)
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To workaround this situation, reenable these services on the subscribers.

 • Updating JTAPI and RMJTPAI users—To update JTAPI and RMJTAPI 
users in Microsoft Active Directory, perform the procedure that is described 
in the “Setting the Access Control Lists for Active Directory” section in 
Installing the Cisco Customer Directory Configuration Plugin for 
Cisco CallManager Release 4.1(3). This document is available at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_installation_
guide09186a00803f5c06.html

Perform this procedure on all servers that are specified in the Cisco CRS 
Administration JTAPI Provider list. In this way, Cisco CRS is able to 
communicate with Microsoft Active Directory via the AVVID XML Layer 
(AXL) interface.

 • ASR/TTS provider becomes IN-SERVICE prematurely—If you delete 
an ASR/TTS provider and all of its associated servers, and then create a new 
ASR/TTS provider, its status might become IN_SERVICE immediately, even 
before you create any servers for it. In this situation, click Refresh for that 
ASR/TTS provider, or click Refresh All. These actions change the status of 
the ASR/TTS provider to OUT_OF_SERVICE. 

 • Agent not deleted automatically when not in LDAP—An agent is no longer 
automatically deleted from the Cisco CRS database when Cisco CRS detects 
that the agent no longer exists in LDAP. Instead, the Cisco CRS 
Administration Resources page includes a new link called Inactive Agents. 
When you click this link, Cisco CRS displays a list of agents that do not exist 
in LDAP but that do exist in the CRS database. In this case, you can select 
certain agents to delete from Cisco CRS by checking the check box next to 
each agent, or you can select all agents for deletion by clicking Check All. 
Then click Delete to remove the selected agents from the Cisco CRS 
database. Until you follow this procedure, agents that no longer exist in 
LDAP continue to appear in the list of agents in Resources page, but they are 
unable to log in because the LDAP authentication is not successful. For more 
information, refer to Cisco CRS Administration Guide.

Note If LDAP errors or errors connecting to the LDAP server occur when you 
display the list of inactive agents, this list might not be accurate. When 
the errors are resolved, click Inactive Agents again to see an accurate list.
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 • Custom report fails with the “Invalid name” error—Attempting to 
generate a scheduled custom report fails with the error “Invalid name” when 
the showUserNameOnReport parameter is set to 1 in the Historical Reports 
hrcConfig.ini file. To work around this problem, add the label @$UserName 
to the .rpt report file that you create with Crystal Reports. To determine where 
to place this attribute, look at the definition file for any of the Cisco-provided 
historical reports.

 • Historical Reports Client version must match Cisco CRS version—If you 
are using Cisco CRS Historical Reports client software, it must be the same 
version as the version of Cisco CRS that you are running.

 • Cisco CallManager Publisher should be the first entry in the list of LDAP 
servers—Before you upgrade from Cisco CRS 3.x or 4.0(x) to Cisco CRS 
4.0(5), make sure that the Cisco CallManager Publisher is the first entry in 
the list of LDAP servers in the Cisco CRS Administration Directory 
Configuration page, as described in the “Installation and Upgrade Notes” 
section in Cisco CRS Installation Guide.

To designate the list of LDAP servers for Cisco CRS 3.x, choose System > 
Configuration and Repository from Cisco CRS Administration to display 
the Directory Setup page. Click the Configuration link on the Directory 
Setup page and make any necessary changes. Then click the Repository link 
on the Directory Setup page and make any necessary changes. For more 
information, refer to Cisco CRS Administration Guide.

To designate the list of LDAP servers for Cisco CRS 4.0(x), choose System 
> LDAP Information from Cisco CRS Administration to display the CRS 
LDAP Server Information page. For more information, refer to Cisco CRS 
Administration Guide.

In addition, when you perform the upgrade, make sure that the IP address or 
the host name of the Cisco CallManager Publisher appears as the first entry 
in the “Enter LDAP server host name, IP address, or AD domain” field in the 
LDAP Server Information window. If the IP address or the host name of the 
Cisco CallManager Publisher does not appear as the first entry in this field, 
correct it manually.

 • ECC variable names should begin with “user”—To ensure that variable 
data is handled properly, make sure that every user-defined Expanded Call 
Context (ECC) variable name begins with “user.”.
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 • Making configuration changes after failover—If a node goes down in a 
high-availability Cisco CRS deployment, you cannot make configuration 
changes in Cisco CRS Administration. To work around this issue, take these 
actions:

 – Make sure the active node is the publisher. If it is not, use Cisco CRS 
Administration to make it the publisher for all datastores.

 – From the Component Activation page in Cisco CRS Administration, 
deactivate the Config Datastore and the Historical Datastore for the 
inactive node.

 • Configuring Cisco IP Communicator—For information about configuring 
Cisco IP Communicator for use with Cisco CRS, refer to the following 
documents:

 – Cisco IP Communicator Administration Guide (2.0)

http://www.cisco.com/en/US/products/sw/voicesw/ps5475/products 
_administration_guide_book09186a00805f06b5.html

 – Install and Configure IP Communicator with CallManager 4.x

http://www.cisco.com/en/US/products/sw/voicesw/ps5475/products 
_tech_note09186a008026d36f.shtml

 • Size of Repository Datastore—The Repository Datastore (named database 
db_cra_repository) stores user prompts, grammars, and documents files. The 
maximum total size of all files and folders that are stored in the Repository 
Datastore on a MCS with a 72 GB hard disk is 1.5 GB. This limitation applies 
even though the size of the Repository Datastore on a server with a 72 GB 
hard disk is 3 GB.

 • Using the CAD with Citrix or Microsoft Terminal Services—IPCC 
Express 4.0(5) supports the running of the Cisco Agent Desktop (CAD) 
within a Citrix or Microsoft Terminal Services environment. For more 
information, refer to:

 – Cisco IPCC Express Edition Solution Reference Network Design, which 
is available at http://www.cisco.com/warp/public/779/largeent/it/ese/ 
unifiedCommunications.html.

 – Integrating CAD into a Citrix MetaFrame Presentation Server or 
Microsoft Terminal Services Environment, which is available at 
http://www.cisco.com/application/pdf/en/us/guest/products/ps427/ 
c1676/ccmigration_09186a00805fd93c.pdf.
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Important Notes
 • AAR manifest file—The AAR manifest file must be in UTF-8 format.

 • Activating a second Cisco CRS Engine Component—To activate a second 
server on which you installed the Cisco CRS Engine component in a 
deployment in which Cisco CallManager is integrated with Microsoft Active 
Directory, perform the following steps.

(If you are attempting to activate the component using the Cisco CRS server 
setup procedure, you can ignore this message that appears on the Component 
Activation Results page: JTAPI information is not created properly, 
please use JTAPI Resynchronize option in JTAPI pages to fix the 

issues. Perform the following steps after you complete the server setup 
procedure.)

a. From the Cisco CRS Administration application, choose System > 
Control Center, and make a note of the ID of the server on which you 
are activating the component.

b. Choose Subsystems > JTAPI > JTAPI Provider and make a note of the 
User Prefix.

c. Create a new user in Microsoft Active directory.

The user name should be JTAPI-user-prefix_node-id. Replace 
JTAPI-user-prefix and node-id with the values that you noted.

The password should be the same as the JTAPI user on the existing 
Cisco CRS Server.

d. From the Cisco CRS Administration application, choose Subsystems > 
JTAPI > Resynchronize, and then click Synchronize.

 • SQL with Mixed Mode Authentication—Cisco CRS does not support the 
use of Mixed Mode authentication for internal SQL with MSDE or SQL 2000.

 • MSDE or MS SQL 2000 Use—If your Cisco CRS system will handle a high 
volume of calls, use the IPCC Express and IP IVR Configuration and 
Ordering Tools, available at the following URL, to determine whether MSDE 
or MS SQL 2000 is the suitable database for your installation.

http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/ 
prod_how_to_order.html
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Important Notes
 • Guidelines for entries in JTAPI CTI Port Group Migration page—Entries 
in the following fields in the JTAPI CTI Port Group Migration page in Cisco 
CRS Administration must follow the guidelines for the corresponding fields 
in Cisco CallManager Administration. For information about these 
guidelines, refer to the Cisco CallManager documentation.

 – Description

 – Display

 – External Phone Number Mask

 • Link to Documentation—The Help page in Cisco CRS Application 
Administration now includes a link called CRS Documentation on 
Cisco.com. This link provides access to the Cisco CRS documentation.

 • CRS 3.x system workflows not migrated—Workflows that were installed 
by Cisco CRS 3.x serve a variety of purposes. Some, such as rm.aef and 
cm.aef, are required for system functionality. Others, such as aa.aef and 
icd.aef, provide examples of system capabilities. If you modify any system 
worflow for your use, make sure to save it under a different name. Sample 
scripts are not propagated when you upgrade Cisco CRS. If you do not 
rename a script, you will lose your changes when you perform an upgrade.

 • Changing LDAP—If you change the LDAP for your installation (for 
example, if you change from DC-Directory to Microsoft Active Directory), 
you must use Cisco CRS Application Administration to reconfigure your 
Cisco CRS data.

 • CRS Editor is not backward compatible—You cannot edit a workflow with 
a version of the Cisco CRS Editor that is older than the version that you used 
to create the workflow.

 • VAD should not be enabled when ASR is used—When setting up a system 
that supports automatic speech recognition (ASR), Voice Activity Detection 
(VAD) should not be enabled anywhere in the network in which voice traffic 
will be transmitted if that traffic is routed to a Cisco CRS server with ASR.

 • Unsupported BARS release—Installing BARS 4.0(9) SR1 install is not 
supported on a Cisco CRS server that is configured as a BARS target.
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Important Notes
 • SQL replication issues—If SQL replication is enabled through the 
Enterprise Manager, extra columns are added to tables in the db_cra database. 
Because of these extra columns, the following message appears when you 
attempt to make configuration changes such as changing or adding skills, 
resource group, or CSQs:

There was an error reading/updating the database. Please contact 
your administrator

To workaround this issue, restore the system from a good backup or reinstall 
Cisco CRS server with MS SQL Server 2000.

 • Installing older CRS release is not supported—You cannot installer a 
release of Cisco CRS that is older than the release that you currently have 
installed.

 • Require Secure Channel [ssl] prevents access to JTAPI subsystem 
options—If Require Secure Channel [ssl] is enabled on the Cisco 
CallManager server and you choose an option in the JTAPI subsystem, you 
are asked for Cisco CallManager authentication, but the operation fails even 
if you enter the proper authentication. To avoid this issue, follow these steps 
on the Cisco CallManager server:

 – Choose Programs > Administrative Tools > Internet Information 
Services (IIS) Manager.

 – Under Internet Information Services, expand the entry for the 
Cisco CRS node.

 – Right-click Default Web Site and choose Properties.

 – Click the Directory Security tab and click Edit in the Secure 
communications area.

 – Uncheck the Require Secure Channel [ssl] check box.

 – Click OK as needed to close the windows.

 • Unable to make modifications to the Cisco CRS cluster—If you are unable 
to upload new prompts, modify teams, or make other similar configuration 
changes in a Cisco CRS cluster that is integrated with Microsoft Active 
Directory, a BARS backup may have failed or the patching process may have 
failed. In this case use the ADSIEDIT.MSC tool to edit the LDAP repository 
and append “?Empty” to Modify archiveID, archiveRequest, 
archiveTimestamp, and archiveUserInfo.
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Unsupported Configurations for Cisco CRS
 • Configuring call forwarding for route points if Cisco CRS is down—If 
you need to change the call forwarding configuration for route points when 
Cisco CRS is not operating, use the Forward on Unregistered option in Cisco 
CallManager administration.

 • Copyright date for Cisco CRS Administration Application—The 
copyright date in the About > Help page that you access through Cisco CRS 
Administration should show the range of 1999–2007.

 • Operating System Language Supported on the Cisco CRS Historical 
Reports client—The Cisco CRS Historical Reporting client supports the 
following operating system languages, which you configure by choosing 
Start > Settings > Control Panel > Regional Options:

 – de_DE (German)

 – en_US (United States English)

 – es_ES (Colombian Spanish)

 – fr_FR (French)

 – it_IT (Italian)

 – ja_JP (Japanese)

 – zh_CN (Simplified Chinese)

 • Database authentication and external connections—The Cisco CRS 
db_cra database now uses windows authentication instead of mixed mode 
authentication. In addition, connections to external databases, other than 
those of supported wallboards, are not supported.

 • End points not supported in hunt groups—Do not assign agent phones, 
CTI ports, or route points that are used by Cisco CRS to hunt groups.

Unsupported Configurations for Cisco CRS
Cisco CRS 4.0(5) does not support the following configurations:

 • Shared lines for CTI ports and for CTI route points.

 • Enabling the multilevel precedence and preemption (MLPP) flag in 
Cisco CallManager Administration.
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Unsupported and Supported Actions for Cisco IPCC Express Agents
 • A call from a CRS route point cannot be redirected to a redirect destination 
that matches any CRS route point, if the call will not be delivered back to 
CRS.

Unsupported and Supported Actions for Cisco 
IPCC Express Agents

This section outlines the unsupported and supported actions for agents using the 
Cisco Agent Desktop or the Cisco IP Phone Agent Service. Agents can access 
similar information in the Cisco Agent Desktop online help.

Unsupported Actions for Cisco IPCC Express Agents
Use of the following softkeys on a Cisco IP Phone is not supported:

 • Barge

 • cBarge

 • DirTrfr

 • GPickup

 • iDivert

 • Join

 • MeetMe

 • Park

 • Pickup
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Unsupported and Supported Actions for Cisco IPCC Express Agents
Supported Configurations for Agent Phones
To determine the phone devices that are supported by the Cisco Agent Desktop 
and for use by Cisco IP Phone Agents, refer to Cisco Customer Response 
Solutions (CRS) Software and Hardware Compatibility Guide, which is available 
at this URL:

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_ 
support_tables_list.html

 • An IPCC Express extension configured on a single device (but not on 
multiple devices).

 • An IPCC Express extension configured in a single device profile (but not in 
multiple device profiles).

 • Multiple agents sharing the same IPCC Express extension, which you can set 
up as follows:

a. Configure the IPCC Express extension on a single phone (not in a device 
profile).

b. Associate that phone with each agent who will use that extension.

c. Select the appropriate directory number (DN) as the IPCC Express 
extension for each agent.

In this configuration, only one agent at a time can be logged in.

Note All agents that currently have the IPCC Express extension to be shared 
must log out before you can configure additional agents to share that 
extension.

Unsupported Configurations for Agent Phones
The following configurations are not supported for agent phones:

 • Two lines on an agent’s phone that have the same extension but exist in 
different partitions. 

 • An IPCC Express extension assigned to multiple devices.
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Unsupported Features in Cisco CallManager
 • Configuring the same IPCC Express extension in more than one device 
profile, or configuring the same IPCC Express extension in any combination 
of device profiles and devices. (Configuring an IPCC Express extension in a 
single device profile is supported.)

 • In the Cisco CallManager Administration Directory Number Configuration 
web page for each IPCC Express line, setting Maximum Number of Calls to 
a value other than 2.

 • In the Cisco CallManager Administration Directory Number Configuration 
web page for each IPCC Express line, setting Busy Trigger to a value other 
than 1.

 • Configuring a Cisco IP Phone with Secure Real-Time Protocol (SRTP) on.

 • No Cisco Call Manager device can be forwarded to the IPCC Express 
extension of an agent.

 • The IPCC Express extension of an agent cannot be configured to forward to 
a Cisco CRS route point.

 • Use of characters other than the numerals 0–9 in the IPCC Express extension 
of an agent.

Unsupported Features in Cisco CallManager
The following Cisco CallManager features are not supported by 
Cisco CRS 4.0(5). These features are disabled by default and should not be 
enabled for Cisco CRS. For more information about these features, refer to the 
Cisco CallManager documentation.

 • Block External to External Transfer.

 • Drop Adhoc Conference When Creator Leaves.

 • Q Signalling (QSIG) Path Replacement (PR).

This feature must be disabled when Cisco CRS is deployed. To disable this 
feature, set the Cisco CallManager service parameters Path Replacement 
Enabled and Path Replacement on Tromboned Calls to False.
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Contact Dispositions in Cisco CRS Real-Time Reports and Historical Reports
 • Forced Authorization Code and Client Matter Code.

Because these feature can be enabled per route pattern, they should be turned 
off for all route patterns in the Cisco CallManager cluster that Cisco CRS 
might use. Enabling these features for route patterns that Cisco CRS does not 
use will not affect Cisco CRS.

In addition, do not use Cisco CallManager Administration to add or change 
CTI ports or route points that are used by Cisco CRS.

Contact Dispositions in Cisco CRS Real-Time 
Reports and Historical Reports

The following notes help clarify information regarding contact dispositions on 
various Cisco CRS real-time reports and historical reports.

 • Many real-time and historical reports show the disposition of a call. The 
Contact Service Queue Activity Report (by CSQ or by Interval) shows calls 
as Handled, Abandoned, and Dequeued. The Contact Service Queue Activity 
Report shows calls as Handled, Abandoned, Dequeued, and Handled by 
Other.

 • A contact that is queued and answered by an agent shows as handled in 
real-time and in historical reports.

 • A contact that is queued but abandoned before it is answered by an agent is 
shown as handled in the Overall IPCC Express Stats real-time report if a 
SetContactInfo step in the workflow marks the call as handled. The call is 
shown as abandoned otherwise. The CSQ IPCC Express Stats real-time report 
shows the call as abandoned in both cases because it does not consider the 
SetContactInfo step.

For more information about theSetContactInfo step, refer to Cisco CRS 
Scripting and Development Series: Volume 2, Editor Step Reference Guide.

 • The historical CSQ reports take into account whether a contact is marked as 
handled by the SetContactInfo step to determine if a contact is dequeued. The 
CSQ IP IPCC Express Stats report does not consider the SetContactInfo step. 
Therefore, if a call is queued, then marked as handled, and then disconnects, 
the historical CSQ reports shows the call as dequeued on the CSQ Activity 
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Cisco CRS Database Changes that affect Custom Historical Reports
Report (by CSQ or by Interval) or as Handled by Other (handled by workflow 
script) on the CSQ Activity Report. The real-time CSQ IPCC Express Stats 
report shows it as abandoned.

 • If the Dequeue step is used, the CSQ historical reports show a contact as 
dequeued on the CSQ Activity Report (by CSQ or by Interval) or as Handled 
by Other (handled by another CSQ, in this case) on the CSQ Activity Report, 
but only if the contact is marked as handled. If a call is dequeued (by the 
Dequeue step), and then disconnects without being marked handled, the CSQ 
historical reports show the contact as abandoned.

 • If a call is dequeued using the Dequeue step and the caller drops, the 
CSQ IPCC Express Stats real-time report shows the call as dequeued. If a call 
is dequeued from CSQ1 and is eventually handled by CSQ2, the CSQ IPCC 
Express Stats report shows the call as dequeued for CSQ1 and handled for 
CSQ2. If a call is queued on multiple CSQs and is eventually handled by 
CSQ1, the CSQ IPCC Express Stats report shows the call as handled for 
CSQ1 and dequeued for all other CSQs.

Cisco CRS Database Changes that affect Custom 
Historical Reports

This section describes changes that were made to the CRS database tables for 
CRS 4.0(x). In includes information that you should review if you have created 
custom reports in CRS 3.x and you want to continue using these reports after you 
upgrade to CRS 4.0(x)

This section uses the following abbreviations for database tables:

 • CCD—for ContactCallDetail

 • CRD—for ContactRoutingDetail

 • CQD—for ContactQueueDetail

 • ACD—for AgentConnectionDetail

 • CSQ—for ContactServiceQueue

Changes to database tables for CRS 4.0(x) include:

 • ContactCallDetail table moved from the db_cra_ccdr database to the db_cra 
database.
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Cisco CRS Database Changes that affect Custom Historical Reports
 • ContactQueueDetail table added to store individual contact service queue 
(CSQ) information. Now information for more than three CSQs can be stored.

 • ContactRoutingDetail table no longer stores individual CSQ information. It 
now stores overall queuing information. Information for individual CSQs 
moved to CQD.

 • NodeID added to CCD, CRD, CQD, and ACD.

 • CRD, CQD, and ACD tables now include qIndex. Corresponding records 
should be joined on qIndex for conference to route point.

Table 2 provides information that you should review if you have created custom 
historical reports that you want to continue using after you upgrade Cisco CRS.

Table 2 Information for Custom CRS Historical Reports

Activity Comments
Cisco CRS 3.x Usage 
Notes

Cisco CRS 4.0 Usage 
Notes

Using the 
ContactCallDetail 
(CCD) table in a 
custom report.

Cisco CRS 3.x stores 
the CCD table in the 
db_cra_ccdr 
database.

Cisco CRS 4.0(x) 
stores it in the db_cra 
database.

Use either of these 
statements:

select * from 
db_cra_ccdr.. 
ContactCallDetail

or

select * from 
db_cra_ccdr.dbo. 
ContactCallDetail

Use this statement

select * from db_cra.dbo. 
ContactCallDetail
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Cisco CRS Database Changes that affect Custom Historical Reports
Using the 
ContactRoutingDetail 
(CRD) table in a 
report to show CSQ 
information.

Cisco CRS 3.x stores 
queue information for 
up to 3 CSQs in the 
CRD table.

CRS 4.0(x) stores 
overall queue 
information in the 
(CRD) table, and 
stores information for 
an unlimited number 
of individual CSQs in 
a new table called 
ContactQueueDetail 
(CQD). 

Calls presented:

CSQ recordID is stored in 
CRD.primaryCSD, 
CRD.CSD1, CRD.CSD2, 
or CRD.CSD3. 
CRD.primaryCSD is the 
CSQ that handled the call. 
The other fields indicate 
the CSQs to which the call 
was presented, but not 
handled.

For example:

CRD.primaryCSD = 1

CRD.CSD1 = 2

CRD.CSD2 = 3

CRD.CSD3 = 4

The call is presented to 
CSQs with recordIDs of 1, 
2, 3, and 4. It is handled by 
the CSQ with recordID 1.

CSQ recordID is stored in 
CQD.targetID, where 
CQD.targetType = 0.

For total calls presented to 
each CSQ recordID, use:

select targetID, 
count(*)from 
ContactQueueDetail 
where targetType = 0 
group by targetID

Table 2 Information for Custom CRS Historical Reports

Activity Comments
Cisco CRS 3.x Usage 
Notes

Cisco CRS 4.0 Usage 
Notes
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Cisco CRS Database Changes that affect Custom Historical Reports
Using the 
ContactRoutingDetail 
(CRD) table in a 
report to show CSQ 
information 
(continued).

Calls handled:

The CSQ recordID that 
handled the call is stored 
in CRD.primaryCSD. If 
the value of this recordID 
is –1, no CSQ handled the 
call.

For total calls handled by 
each CSQ, use:

select targetID, count(*) 
from ContactQueueDetail 
where targetType = 0 and 
disposition = 2 
group by targetID.

You can also join CQD 
with CCD to check that 
CCD.contactDisposition 
= 2, and you can join CQD 
with ACD to check that 
ACD.talkTime is 
non-zero.

Calls abandoned:

The CSQ recordID from 
which the call is 
abandoned is stored in 
CRD.CSD1, CRD.CSD2, 
or CRD.CSD3. 
CCD.contactDisposition 
should be 1.

For total calls abandoned 
from each CSQ:

select targetID, count(*) 
from ContactQueueDetail 
where targetType = 0 and 
disposition = 1 
group by targetID

Table 2 Information for Custom CRS Historical Reports

Activity Comments
Cisco CRS 3.x Usage 
Notes

Cisco CRS 4.0 Usage 
Notes
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Cisco CRS Database Changes that affect Custom Historical Reports
Using the 
ContactRoutingDetail 
(CRD) table in a 
report to show CSQ 
information 
(continued).

Calls dequeued:

Scenario 1: Call is 
handled by a script and 
dequeued from all CSQs 
that it was queued for.

The CSQ recordID is 
stored in CRD.CSD1, 
CRD.CSD2, or 
CRD.CSD3. 
CRD.primaryCSD should 
be –1, and 
CCD.contactDisposition 
should be 2 (handled). 
ACD should not be 
present, or ACD.talkTime 
= 0 (ring-no-answer).

Scenario 2: Call is 
handled by one of the 
CSQs and dequeued from 
all the others.

The CSQ recordID is 
stored in CRD.CSD1, 
CRD.CSD2, or 
CRD.CSD3. 
CRD.primaryCSD is the 
recordID of the CSQ that 
handled the call. ACD 
should be present, with 
talkTime not equal to zero

For total calls dequeued 
from each CSQ:

select targetID, count(*) 
from ContactQueueDetail 
where targetType = 0 and 
disposition in (3, 4, 5) 
group by targetID

Table 2 Information for Custom CRS Historical Reports

Activity Comments
Cisco CRS 3.x Usage 
Notes

Cisco CRS 4.0 Usage 
Notes
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Adding a 15-Minute Interval Length to a Cisco CRS Historical Report Filter Parameter
Adding a 15-Minute Interval Length to a Cisco CRS 
Historical Report Filter Parameter

The following Cisco CRS historical reports provide filter parameters that let you 
display information for 30-minute intervals or for 60 minute intervals within the 
report period.

 • Contact Service Queue Activity Report (by CSQ)

 • Contact Service Queue Activity Report (by Interval)

Joining CCD, CRD, 
ACD on sessionID, 
sessionSeqNum, and 
profileID.

For CRS 4.0(x) multi 
node deployments, 
you must to join the 
tables on nodeID.

Use this statement:

select * from CCD, CRD 
where CCD.sessionID = 
CRD.sessionID and 
CCD.sessionSeqNum = 
CRD.sessionSeqNum and 
CCD.profileID = 
CRD.profileID

Use this statement:

select * from CCD, CRD 
where CCD.sessionID = 
CRD.sessionID and 
CCD.sessionSeqNum = 
CRD.sessionSeqNum and 
CCD.profileID = 
CRD.profileID and 
CCD.nodeID = 
CRD.nodeID

Joining CRD and 
ACD to display CSQ 
and agent 
information.

In CRS 4.0(x), a new 
table called 
ContactQueueDetail 
is created to store 
CSQ information for 
individual CSQs. In 
addition, CQD and 
ACD join on qIndex 
to identify the agent 
that handled a call 
when the call is 
conferenced to a route 
point.

Use this statement:

select * from CRD, ACD 
where CRD.sessionID = 
ACD.sessionID and 
CRD.sessionSeqNum = 
ACD.sessionSeqNum and 
CRD.profileID = 
ACD.profileID

Use this statement:

select * from CQD, ACD 
where CQD.sessionID = 
ACD.sessionID and 
CQD.sessionSeqNum = 
ACD.sessionSeqNum and 
CQD.profileID = 
ACD.profileID and 
CQD.nodeID = 
ACD.nodeID and 
CQD.qIndex = 
ACD.qIndex

Table 2 Information for Custom CRS Historical Reports

Activity Comments
Cisco CRS 3.x Usage 
Notes

Cisco CRS 4.0 Usage 
Notes
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Adding a 15-Minute Interval Length to a Cisco CRS Historical Report Filter Parameter
 • Agent State Summary Report (by Agent)

 • Agent State Summary Report (by Interval)

 • Common Skill Contact Service Queue Activity Report (by Interval)

You can add a filter parameter that lets you display information for 15-minute 
intervals during the report period. To do so, follow these steps:

Procedure

Step 1 Locate the report definition file for the report that you want to update and make a 
backup copy of this file.

Report definition files have descriptive names and are located in the following 
folder under the folder in which you installed the Cisco CRS Historical Report 
client system (by default, the client system installs in the Program Files 
directory):

Cisco CRS Historical Reports\ReportTemplates\Language

For example, the report definition file for the U.S. English version of the Contact 
Service Queue Activity Report (by Interval) report is named:

ICD_Contact_Service_Queue_Activity_by_Interval_en_us.xml

By default, this file is located in this directory:

C:\Program Files\Cisco CRS Historical Reports\ReportTemplates\EN_us

Step 2 Use a Windows text editor to open the report definition file for the report that you 
want to update.

Step 3 In the report definition file, locate this line:

<ListOption OptionSelected="True" OptionValue="0">Entire report range</ListOption> 

Step 4 Insert this line immediately after the line that you located:

<ListOption OptionSelected="False" OptionValue="15">Fifteen (15) minutes</ListOption> 

Now there is a series of lines in the file that looks like this:

<ListOption OptionSelected="True" OptionValue="0">Entire report range</ListOption>
<ListOption OptionSelected="False" OptionValue="15">Fifteen (15) minutes</ListOption> 
<ListOption OptionSelected="False" OptionValue="30">Thirty (30) minutes</ListOption> 
<ListOption OptionSelected="False" OptionValue="60">Sixty (60) minutes</ListOption>
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Caveats
Step 5 Save your changes and exit the text editor.

A new option for the Interval Length filter parameter is available for the report 
that you updated. The new option lets you designate a 15-minute interval for the 
report.

Caveats
This section includes the following topics:

 • Using Bug Toolkit, page 32

 • Known Limitation(s), page 33

 • Open Caveats, page 39

 • Closed Caveats, page 42

Using Bug Toolkit
If you are a registered Cisco.com user, you can find the latest information about 
resolved, open, and closed caveats for Cisco CRS by using Bug Toolkit, an online 
tool that allows you to query caveats according to your own needs. By using Bug 
Toolkit, you can find caveats of any severity for any release. Bug Toolkit may also 
provide a more current listing than this document provides.

To access Bug Toolkit, you need:

 • Internet connection 

 • Web browser 

 • Cisco.com user ID and password
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Caveats
To use Bug Toolkit, follow these steps:

Procedure

Step 1 Go to this URL to access the Bug Toolkit:

http://tools.cisco.com/Support/BugToolKit/action.do?hdnAction=searchBugs

Step 2 Log on with your Cisco.com user ID and password.

Step 3 To access Cisco CRS caveats, take either of these actions:

 • To access a particular caveat when you know its identifier, enter the identifier 
in the Search for Bug ID field and click Go.

 • To access all caveats, follow these steps:

a. From the Select Product Category list, choose Voice and Unified 
Communications.

b. From the Select Product list, choose Cisco Unified Contact Center 
Express.

c. From the Software Versions drop-down list, choose the desired Cisco 
CRS release.

d. Click the desired Advanced Options radio button

If you choose custom settings, enter appropriate custom information.

e. Click Search.

A list of caveats that match your search criteria appear. To see details about 
any caveat, click its Bug ID number or click its Info link.

Known Limitation(s)

Limitation 1

Identifier Headline

CSCsz58742  Need to prevent scripts from being loaded when mem too high.
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Problem   

When there are a large number of applications configured, the engine runs out 
memory at or soon after startup. This is likely when there is a configuration such 
as the same script being used with many different applications, each with a 
separate trigger. This is due to the script being loaded into memory for each 
application configured.

Workaround   

It is recommended that if such a scenario exists, the scripting features of reading 
application parameters from a common store, such as an XML file are used to 
configure a single application with that script, and associate multiple triggers to 
that single application. This will cause the script to only be loaded into memory 
once, greatly reducing memory usage.

For details, refer to the online record for the defect, CSCsz58742, using Bug 
Toolkit. This issue will be resolved in a future release or SR.

Resolved Caveats
Table 3 lists Severity 1, 2, and 3 defects that are resolved in this release of 
Cisco CRS.

For more information about an individual defect, you can access the online record 
for the defect by clicking the Identifier or going to the URL shown. You must be 
a registered Cisco.com user to access this online information.

Because defect status continually changes, be aware that Table 3 reflects a 
snapshot of the defects that were resolved at the time this report was compiled. 
For an updated view of resolved defects, access Bug Toolkit as described in the 
“Using Bug Toolkit” section on page 32.

Table 3 Resolved Caveats 

Identifier Headline and Bug Toolkit Link

CSCsb75577 CRS 4.5 installation stuck when removing backup files

CSCsb88320 Node recovery during restore prompts for reboot before recovering—Part 2
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CSCsc60171 Title of the screen is corrupted in Cisco Agent Desktop client installer

CSCsc63563 Upload documentation step does not log error when upload fails

CSCsc65438 Unable to change codec by re-installing

CSCsc72942 SQL Utility is invoked every time on restarting the CRS machines

CSCsc85283 JCUpdateInstall displays: The account name field cannot be left blank

CSCsd36626 Transfer softkey shown when initiating conference with Cisco Agent Desktop

CSCsd54210 CRA 4.0 call stuck in queue using Call Consult Transfer step

CSCsd58731 Prompts with upper case file extension (.WAV) do not show up in the Prompt 
Management page

CSCsd66230 When restore fails, temporary folders for restore are not cleaned up

CSCsd66445 In Cisco CRS 4.0(4), after logout, can still access Appuser and Appsupervisor 
pages

CSCsd67516 CRA 4.0 SQL 2000 installs Microsoft Search service as automatic start

CSCsd78873 Blank page during JTAPI migration if JTAPI user is deleted from Cisco 
CallManager

CSCsd79065 WorkflowTask needs to be purged in addition to CSCsd78732

CSCsd79715 Bulk Spoken Upload tool does not work with CRS 4.x

CSCsd80752 Japanese characters are shown as question marks when coming from DB

CSCsd81792 ClusterManagerImpl in Editor needs to retrieve local registry

CSCsd83135 Cisco Agent Desktop does not install if the PC has Internet Explorer version 7

CSCsd85869 Proper message has to be given while activating Engine node on second active 
Directory setup

CSCsd86983 Upgrade fails to migrate recordings, upgrade tool displays error

CSCsd92109 Killing LDAP Monitor service results in CPU spike and possible blue screen

CSCsd94107 Cisco CRS Application Administration adds CTI ports incorrectly

CSCsd98903 Instructions for LDAP sync incorrect in Cisco Agent Desktop Service 
Information Guide

CSCse01027 Cisco Agent Desktop shows incorrect call Total Time for RNA call

Table 3 Resolved Caveats (continued)

Identifier Headline and Bug Toolkit Link
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CSCse03410 Changing agent information while agent logged in corrupts historical reports

CSCse18726 Upgrade 3.5.3 to 4.0.4: CSQ report shows abandoned calls as dequeued

CSCse18751 Upgrade 3.5.3 to 4.0.4: number of calls handled decreases on CSQ reports

CSCse20368 Cisco Customer Response Solutions Historical Reporting Administrator and 
Developer Guide has incorrect information on custom call variables

CSCse21480 CRS CreateGeneratedPrompt plays back of dollar for US currency

CSCse30766 Editor does not work remotely when jar file is uploaded

CSCse38244 Upgrade fails due to SLCfgArchiveComponent

CSCse40038 Cisco CRS Application Administration ICM VRU Script problem

CSCse42142 License upgrade fails if duplicated server lines exist

CSCse47441 Telecaster user cannot change password/complexity in Active Directory

CSCse47483 Cluster profile gets duplicated when LDAP configuration is updated

CSCse49879 List of supported IP Phones in Cisco Agent Desktop Installation Guide should 
be updated

CSCse59817 Remove incorrect warning messages from SQL error logs

CSCse60610 LDAP monitor issue makes the agents get True update error

CSCse60951 Error message popping up while conferencing

CSCse62381 Migrate the agent personal employee phone book during an upgrade

CSCse62485 Support 40 ms frame size for media packets

CSCse62933 Resource configuration cannot be done for agent IDs having special characters

CSCse63244 Upgrade fail when there is a blank Cisco Agent Desktop phonebook entry

CSCse68653 Primary keys missing in tables in db_cra database

CSCse70861 Add checking for NULL into the PLACE CALL code in CRS

CSCse71018 Voice browser does not handle modal built in grammars correctly

CSCse71123 Cisco Desktop Administrator crashes when the maximum layouts of 16 reached 
in Enterprise Data

CSCse73377 Cisco Agent Desktop client agent.exe goes to 100% CPU utilization

CSCse76731 Debug of script with DBWrite step results in Object not Found exception

Table 3 Resolved Caveats (continued)

Identifier Headline and Bug Toolkit Link
36
Release Notes for Cisco Customer Response Solutions 4.0(5/5a)



Caveats
CSCse83848 Real-Time Reporting CSQ statistic does not show call as dequeued

CSCse87372 Install failure due to scripts missing *.aef* extension

CSCse89233 Application Summary report does not show all selected applications

CSCse90245 Garbled message pop up at Cisco Agent Desktop start up

CSCse90555 Null Pointer Exception while executing DBRead from the Editor

CSCse92070 Multi-stage upgrade losing seats information

CSCse94659 Setup does not check if LDAP configuration points to subscriber, resulting in 
bad upgrade

CSCse95054 Upgrade CRS: in BARS, server order list changes during upgrade

CSCse98604 Transfer non-existent call fails when ConnFailed event received

CSCse99031 CCDR record not written when agent is in work state then logs out

CSCsf00686 Historical Reporting cleanup does not write missing CCDR records

CSCsf05541 Error saving Agent Login Logout Activity report in CRS Historical Reporting

CSCsf06953 Redirect step causes Cisco Agent Desktop Transfer button to be replaced with 
Dial

CSCsf09352 Cisco Agent Desktop does not pop up for calls coming through the gateway

CSCsf11089  Filtering by route group on Agent Call Summary report returns All Resources 

CSCsf11662 Agent goes to Not Ready state after making outbound call from Ready state

CSCsf16527 Calls stuck in queue due to race condition

CSCsf16679 CRS Installer should remind/prompt the user to run the Pre-Upgrade Check Tool

CSCsf18408 Cisco Agent Desktop, Cisco Supervisor Desktop site setup registry not updated 
after adding node to cluster

CSCsf18853 Agent Not Ready Reason Code Report error when using multiple filters

CSCsf19461 ContactTransferredEvent should contain consult sessionSeqNum

CSCsf21708 BARS restore stalls waiting for user to upgrade 3.x dedicated server

CSCsf26132 Cisco CRS Application Administration to check the DB Editor when customer 
activates high availability node

CSCsf27242 Cisco Agent Desktop agent call log shows N/A after upgrade

Table 3 Resolved Caveats (continued)

Identifier Headline and Bug Toolkit Link
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CSCsf27553 Need to update the process documented for rolling back a service release

CSCsf27694 Consult transfer reports success even when off-network destination does not 
answer

CSCsf29964 RM and RTDM out of sync, agent information for CSQs incorrect

CSCsf30145 Cisco CRS Application Administration does not properly show the reason why 
update is not allowed

CSCsf97649 CRS patch install instructions are unclear when referencing database server

CSCsf98369 Complex transfer scenario can result in incorrect agent state

CSCsg01029 Get Enterprise Data step does not convert correctly after upgrade

CSCsg03918 Reinstall of IPCC Express 4.0(4) SR1 causes errors

CSCsg03998 CRS install does not check whether server is not part of domain before upgrade

CSCsg05499 Documentation: Upgrading IPCC Express from version 3.1(2) to 4.0(4)9

CSCsg06441 Documentation: Need BARS 4.0.10 or later for CRS 4.0.4 upgrade

CSCsg08948 Step 1 of Replacing the Cisco CRS server in Installation Guide has wrong link

CSCsg08957 Add 3.x to 4.0 Upgrade alternative procedure that bypasses 3.x uninstall

CSCsg09279 Documentation: Naming convention for recorded files

CSCsg10430 Installation Guide falsely refer to Administration Guide for an unsupported 
procedure

CSCsg17807 Documentation does not specify whether you can have different versions

CSCsg28125 Error in output window from CRS4PreUpgradeCheck.bat

CSCsg31237 Cannot edit the Call Control Group with 10 digit directory

CSCsg32058 CRS 4.0 Pre-Upgrade Check Tool requires running from a command prompt

CSCsg32067 User must manually enter URL to check if CRS 4.0(4) upgrade will run

CSCsg32073 Browser is not able to download Java applets

CSCsg32085 Upgrade to CRS 4.0(4) requires publisher server to be running

CSCsg32101 This server belongs to a different cluster; you must uninstall Cisco CRS

CSCsg32106 CRS 4.0(4) upgrade hangs indefinitely on license file comparison

CSCsg32119 Upgrade License Conversion Tool does not auto-close

Table 3 Resolved Caveats (continued)

Identifier Headline and Bug Toolkit Link
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Open Caveats
Table 4 lists Severity 1, 2, and 3 defects that are open in this release of Cisco CRS.

For more information about an individual defect, you can access the online record 
for the defect by clicking the Identifier or going to the URL shown. You must be 
a registered Cisco.com user to access this online information.

CSCsg32132 No reference to pop-up “This server belongs to a different cluster”

CSCsg37090 User prompted for the CRS 3.5 and 4.0 license path

CSCsg37094 User prompted for the CRS 4.0 license path

CSCsg37095 CRS Pre-Upgrade Check Tool does not auto-scroll to the last window display 
entry

CSCsg37097 Please initiate a backup of all the CRS server(s) using the Cisco Backup

CSCsg37098 Typo on install screen

CSCsg37100 Click OK when backup is done

CSCsg37102 Upgrade indication to perform restore is not intuitive

CSCsg37118 Now the system will restart; please continue with the setup

CSCsg37120 This node must be recovered; click Next to recover it

CSCsg37129 Documented Maximum AXL Writes Allowed per Minute value incorrect

CSCsg37130 CRS log collection is a manual operation

CSCsg37523 Cannot create CTI ports with a leading zero using Cisco CRS Application 
Administration

CSCsg43973 Typo in Cisco Customer Response Solutions Installation Wizard

CSCsg48077 CSQ Agent Summary Report does not sort by agent name

CSCsg48136 CSQ-Agent Report Missing RNA if agent handles 0 calls

CSCsg55597 CRS Engine in partial service while all services under Engine are in service

CSCsg73199 Documentation should state new profile name needed during re-install

CSCsh16920 Copyrights year not updated in CRS About and Help pages

Table 3 Resolved Caveats (continued)

Identifier Headline and Bug Toolkit Link
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Because defect status continually changes, be aware that Table 4 reflects a 
snapshot of the defects that were open at the time this report was compiled. For 
an updated view of open defects, access Bug Toolkit as described in the “Using 
Bug Toolkit” section on page 32.

Table 4 Open Caveats 

Identifier Headline and Bug Toolkit Link

CSCsa88391 ICD report stops updating and does not respond if kept open for a few hours

CSCsd38512 ACDR with no matching CCDR for out of system then back in transfer

CSCsd42186 Incorrect CCD and CRD record linkage

CSCsd58815 Agent does not get any message while exiting the application

CSCsd66694 CRS Admin Utility—Serviceability Utility error—Empty node

CSCsd69608 BInding order of Cisco Telephony Operating System Windows 2000 has second 
NIC first

CSCsd70895 Add node2 after 3.x upgrade with group default language causes node2 invalid

CSCsd71976 Failed to upgrade after canceling install for several times

CSCsd73928 Speech server setup install: Setup initialization pop-up error 111

CSCsd79065 Installer to clean up workflow data during upgrade

CSCsd84209 Agent with user ID greater than 24 characters is not seen on Cisco Agent 
Desktop

CSCsd84491 Replication snapshot fails for CRSProperties with primary key violation

CSCse01600 Restore failed to restore configuration done from Cisco Desktop Administrator 
with special character

CSCse06416 Error in uploading zipped license file containing a sub-folder

CSCse15624 ArrayIndexOutOfBoundsException in the Repository layer

CSCse51070 Errors, and editor crashing

CSCse54564 Unable to login to Cisco CRS Application Administration or Historical 
Reporting client after Active Directory failover

CSCse79713 Historical Reporting Scheduler cannot print reports on printer behind print 
server

CSCse86950 Cisco CRS Application Administration should be case insensitive when new 
entries are created
40
Release Notes for Cisco Customer Response Solutions 4.0(5/5a)



Caveats
CSCse87304 SR3 installer for CRS 3.5(3) throws AutoIt Error / Runwait error

CSCsf18243 Cisco Supervisor Desktop barge, then intercept drops calls

CSCsf25410 CRS upgrade populates users with blank passwords in LDAP

CSCsf25773 JTAPI stuck on creating port during upgrade migration

CSCsg02563 Incorrect Cisco Agent Desktop version for IPCC Express in documentation

CSCsg13926 Documentation: Steps for configuring enterprise data for IP phone agent 
missing

CSCsg18832 Timestamp in logs does not match Windows time using (–6 GMT Mexico City)

CSCsg19498 Indications required for agents are not showing up in Resource page

CSCsg23031 Blind transfer causing problem

CSCsg24966 When LDAP is corrupted in Active Directory, the PATH of missing OU not 
shown

CSCsg31871 Agent stuck in Reserved state, multiple Select Resource steps for one contact

CSCsg32337 Rename function does not work in prompt management page

CSCsg40935 Uploading prompt ZIP file to repository larger than maximum gives no error

CSCsg58451 Cisco CallManager LDAP information section, Active Directory domain name 
does not work.

CSCsg63311 Updating Redirect CSS in JTAPI CallControlGroup does not take effect

CSCsg67618 Agents are not selected based on CSQ resource group criteria of linear

CSCsg71357 All call control groups are deleted when DCD refuses the connection to IPCC

CSCsg80300 Misleading error message when creating JTAPI provider

CSCsg84928 CTI ports do not register and JTAPI subsystem out of service

CSCsg90767 RingTime value intermittently incorrect in AgentConnectionDetail

CSCsg95726 Error while activating datastores during server setup

CSCsg96531 Multiple users making changes can create mutex lock issue

CSCsg96745 Call Pickup Group option on JTAPI trigger should be removed

CSCsg98024 CRS engine crashes with java.lang.OutOfMemoryError on 4.0(4)SR1

CSCsg98359 License update tool not updating to full 300 IVR ports

Table 4 Open Caveats (continued)

Identifier Headline and Bug Toolkit Link
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Closed Caveats
Table 5 lists Severity 1, 2, and 3 defects that are closed in this release of 
Cisco CRS.

For more information about an individual defect, you can access the online record 
for the defect by clicking the Identifier or going to the URL shown. You must be 
a registered Cisco.com user to access this online information.

Because defect status continually changes, be aware that Table 5 reflects a 
snapshot of the defects that were closed at the time this report was compiled. For 
an updated view of closed defects, access Bug Toolkit as described in the “Using 
Bug Toolkit” section on page 32.

CSCsg99597 Supervisor desktop statistics sorting report error

CSCsh16033 Clients using True Update to upgrade will fail if Internet Explorer 7 is installed

CSCsk15778 Current CRS time in Real-Time Reporting is not changing for NZ DST

Table 4 Open Caveats (continued)

Identifier Headline and Bug Toolkit Link

Table 5 Closed Caveats 

Identifier Headline and Bug Toolkit Link

CSCsa75270 Color code in historical reports is not translated in specific languages

CSCsa78184 Tracking: Hiranaga/Katakana grammars do not work with ScanSoft MRCP

CSCsa81329 Caller hears fast busy after agent completes transfer using Task button on Cisco 
Agent Desktop

CSCsa83464 Non-SSML non-ASCII characters not played correctly

CSCsa91654 CDP driver service fails to start

CSCse68936 Using .after() or .before() with T[] variable does not work correctly.

CSCsg37137 User must manually stop and disable virus software prior to CRS upgrade

CSCsg48048 CSQ Agent Summary Report does not filter by agent name 
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Documentation Updates
The following sections provide documentation changes that were unavailable 
when the Cisco CRS 4.0(5) documentation was released:

 • Documentation Updates for Cisco CRS Administration Guide, page 43

 • Documentation Updates for Cisco CRS Installation Guide, page 49

 • Documentation Updates for Cisco CRS Historical Reports User Guide, 
page 53

 • Documentation Updates for Cisco Customer Response Solutions Historical 
Reporting Administrator and Developer Guide, page 53

 • Documentation Updates for Cisco CRS Scripting and Development Series, 
page 66

 • Documentation Updates for Cisco CRS Scripting and Development Series: 
Volume 1, Getting Started with Scripts, page 66

 • Documentation Updates for Cisco CRS Scripting and Development Series: 
Volume 2, CRS Editor Step Reference Guide, page 67

 • Documentation Updates for Cisco Customer Response Solutions Servicing 
and Troubleshooting Guide, page 68

Documentation Updates for Cisco CRS Administration Guide
The following update applies to the “Provisioning Additional Subsystems” 
chapter:

In the “Defining an ODBC Data Source” section, the Note in Step 7 which 
currently reads as ‘When you want the workflow application script to read 
information from the db_cra CRS database, then select the Windows NT radio 
button as the authentication mode in a separate DSN. This choice provides 
read-only access to the db_cra database.’ should be replaced with “CRS does not 
support configuring CRS and CCM databases as Enterprise DB servers.”

Other updates include:

 • “Updates to the “Managing Prompts, Grammars, Documents, and Custom 
Files” Chapter” section on page 44

 • Updates to the “Managing the Cisco CRS System” Chapter, page 44
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 • Updates to the “The Applications Menu” Chapter, page 47

 • Updates to the “The Tools Menu” Chapter, page 48

Updates to the “Managing Prompts, Grammars, Documents, and Custom Files” 
Chapter

The following note applies to the “Managing Prompts, Grammars, Documents, 
and Custom Files” chapter:

If you receive the error “The page cannot be displayed” in Cisco CRS 
Administration when trying to upload a large prompt .wav file, manually move 
the file to the repository to resolve the issue.

Updates to the “Managing the Cisco CRS System” Chapter

The following update applies to the procedure in the “Migrating to a Different 
LDAP Directory” section in the “Managing the Cisco CRS System Chapter”:

 • Insert this new step immediately after Step 3:

Run the plug-in for the required directory in the Cisco CallManager 
Administration web page.

See the Installing the Cisco Customer Directory Configuration Plug-in for 
Cisco CallManager Release 4.1(3) procedure at the following website:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_installation 
_guide09186a00803f5c06.html.

This website describes the Cisco CallManager migration process for DCD, 
AD, and ND.

 • Remove Step 12.

The following sections replace the existing information in the “Examples: 
Updating Cisco CRS IP Address information” section in Chapter 8, “Managing 
the Cisco CRS System” of the Cisco CRS Administration Guide.

Scenario 1: Cisco CRS Collocated with Unified CallManager 

In a deployment consisting of Cisco CRS collocated with Unified CallManager, 
do the following to update the IP address on the nodes in the cluster:

1. Stop the Cisco CRS Node manager from the Services window.
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2. Use the Windows TCP/IP Properties window to modify the IP address of the 
machine.

3. Update the DNS server so that new IP address matches the old host name.

4. Assuming that the Unified CallManager IP address has changed, follow the 
instructions in the Unified CallManager user documentation for editing the IP 
address.

5. If you have Cisco IPCC Express, run the Cisco Agent Desktop Configuration 
Setup by double clicking the PostInstall.exe file (located under C:\Program 
files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary 
CAD Directory Service, click OK, 

You will get an error message “Error connecting to Directory Service. 
Do you want to try it again? The process may take time. Press Yes 

to retry Directory Service connection. Press No to proceed without 

Directory Service functionality.” Click No in this dialog box. Then 
modify the IP address under the appropriate subsequent screens (such as 
Unified CallManager, VoIP Network Device and service IP address).

6. Launch the CRS Serviceability Utility and follow these steps:

a. When launching the tool (assuming Unified CallManager is using DCD, 
if that is not the case then skip this step), it cannot connect to LDAP, as 
the Unified CallManager IP address is changed. A dialog box appears 
displaying the old connection details. Enter the new IP address and click 
Sync; the utility updates the LDAP server and ccndir.ini, and the tabs are 
populated with the data.

b. Go to the Node Information tab and select the node for which the IP 
address has to be changed. Select the IP address from the drop-down list, 
enter the new IP address and click Update. 

Note You need to perform this step on all the nodes in the cluster.

c. Go to the Unified CallManager LDAP tab, enter the new IP address, and 
click Update.

d. Go to the Unified CallManager IP Address tab. Update RmCm JTAPI 
Provider and JTAPI Provider with the new IP address and click Update.

e. Exit the Serviceability utility.

7. Reboot the Node.
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8. If you have Cisco IPCC Express and you have configured IP Phone Agent 
(IPPA) service on Unified CallManager, access the Call Manager 
Administration page, update the URL in the IPPA service with new IP 
address, and click Update subscriptions.

Scenario 3: Seven-Node Cluster 

In a seven-node cluster containing CRS on Node 1 and Node 2, VoIP on Node 3 
and Node 4, RDB on Node 5 and Node 6, and Unified CallManager on Node 7, 
do the following to update the IP address on the nodes in the cluster:

1. Stop the CRS Node manager from the Services window on every node in the 
cluster.

2. Use the Windows TCP/IP Properties window to modify the IP address on all 
machines in the cluster.

3. Update the DNS server so that the new IP addresses to match old host names.

4. For Node 7 (CCM), follow the instructions as specified for Unified 
CallManager, assuming the Unified CM IP has changed.

5. For Node 1 (CRS), follow Scenario 1’s Steps 6.a, 6.b, 6.c, 6.d and 6.e.

6. If you have Cisco IPCC Express, run the Cisco Agent Desktop Configuration 
Setup by double clicking the PostInstall.exe file (located under C:\Program 
files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary 
CAD Directory Service, click OK,

You will get an error message “Error connecting to Directory Service. 
Do you want to try it again? The process may take time. Press Yes 

to retry Directory Service connection. Press No to proceed without 

Directory Service functionality.” Click No in this dialog box. Then 
modify the IP address under the appropriate subsequent screens (such as 
Unified CM, VoIP Network Device and service IP address).

7. For Node 2 (CRS), follow Scenario 1’s Steps 6.a, 6.b, and 6.e.

8. For Node 3 (VoIP): 

a. Run the Cisco Agent Desktop Configuration Setup by double clicking the 
PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) 
and modify the IP address of the Primary/Secondary CAD Directory 
Service, click OK, 
 
You will get an error message “Error connecting to Directory 
Service. Do you want to try it again? The process may take time. 
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Press Yes to retry Directory Service connection. Press No to 

proceed without Directory Service functionality.” Click No in 
this dialog box. Then modify the IP address under the appropriate 
subsequent screens (such as Unified CM, VoIP Network Device and 
service IP address).

b. Follow Scenario 1’s Steps 6.a, 6.b, and 6.e.

9. For Node 4 (VoIP)

a. Run the Cisco Agent Desktop Configuration Setup by double clicking the 
PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) 
and modify the IP address of the Primary/Secondary CAD Directory 
Service, click OK, 
 
You will get an error message “Error connecting to Directory 
Service. Do you want to try it again? The process may take time. 

Press Yes to retry Directory Service connection. Press No to 

proceed without Directory Service functionality.” Click No in 
this dialog box. Then modify the IP address under the appropriate 
subsequent screens (such as Unified CM, VoIP Network Device and 
service IP address).

b. Follow Scenario 1’s Steps 6.a, 6.b, and 6.e.

10. For Node 5 (RDB), follow Scenario 1’s Steps 6.a and 6.e.

11. For Node 6 (RDB), follow Scenario 1’s Steps 6.a and 6.e.

12. Finally, reboot all the nodes.

Updates to the “The Applications Menu” Chapter

The following note applies to the “Prompt Management” section in the “The 
Applications Menu” chapter:

Note: You can use a custom script or the Cisco CRS Administration to upload a 
prompt.
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Updates to the “The Tools Menu” Chapter

The following procedure replaces the wallboard set up procedure that is described 
in the “The Real-time Snapshot Config Menu Option” section in the “The Tools 
Menu” chapter:

Procedure

Step 1 On the wallboard client desktop, use the standard Windows Computer 
Management feature to create a new Windows NT account or a new local user, 
called CiscoWbUsr.

Make a note of the password for the new CiscoWbUsr account. 

Step 2 On the Cisco CRS server, change the password for the CiscoWbUsr account to be 
the same as the password on the wallboard client desktop. 

Step 3 From the wallboard client desktop, log in as CiscoWbUsr.

Step 4 Install the wallboard software on the wallboard client desktop.

Step 5 Create a system DSN on your Windows 2000 Professional or Windows 2000 
server by choosing Start> Programs > Administrative Tools > Data Sources 
(ODBC).

The OBDC Data Source Administrator window opens. 

Step 6 Click the System DSN tab and click Add.

The Create New Data Source window opens. 

Step 7 In the Create New Data Source window, choose a SQL Server driver and click 
Finish.

The first Create a New Data Source to SQL Server window opens. 

Step 8 In the first Create a New Data Source to SQL Server window, perform the 
following tasks:

a. In the Name field, specify a name for this DSN (for example, Wallboard.)

b. In the Description field, enter a descriptive name.

c. In the Which SQL Server field, enter CRSServer\CRSSQL.

Step 9 Click Finish.

The second Create a New Data Source to SQL Server window opens. 
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Step 10 In the second Create a New Data Source to SQL Server window, click the 
Windows NT server authentication radio button. 

Step 11 Click Next.

The third Create a New Data Source to SQL Server window opens. 

Step 12 In the third Create a New Data Source to SQL Server window, change the default 
database to db_cra and click Next.

The fourth Create a New Data Source to SQL Server window opens. 

Step 13 In the fourth Create a New Data Source to SQL Server window, click Finish.

The ODBC Microsoft SQL Server window opens.

Step 14 In the ODBC Microsoft SQL Server window, click Test Data Source.

If the phrase Test completed successfully is returned, click OK.

If the test is unsuccessful, return to the configuration sequence and fix any errors.

Documentation Updates for Cisco CRS Installation Guide
 • The following update applies to the “Patching Cisco CRS” chapter:

 – In the “Before You Begin” section, include this as the first bullet:

Restart/Reboot the Cisco CRS server on which you want to install the 
patch.

 • The following update applies to the Verifying Hardware Settings and 
Connectivity section of the Installation and Upgrade Requirements, 
Prerequisites, and Related Procedures chapter:

Configuring Speed and Duplex Settings:

Step 5: Should read as ‘Set Speed and Duplex to Auto.’

 • The following update applies to the Installation and Upgrade Requirements, 
Prerequisites, and Related Procedures chapter:

Add a new section named “Guidelines for Deploying High Availability” as shown 
below:
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Guidelines for Deploying High Availability

The following sections provide guidelines that you should follow if you deploy a 
Cisco CRS solution with high availability:

Guidelines for Deploying High Availability with Two Servers

If you are deploying high availability in an environment with two servers, perform 
the following general steps in this order.

Note If servers have different hard disk sizes, use the server with smaller disk 
as the active server and use the server with the larger disk as the standby 
server.

1. Install the Cisco CRS Engine, all the Datastore components, and Microsoft 
SQL Server 2000 on the server that will be the active server before you reboot 
the server.

2. Activate all Cisco CRS components on the active server

3. Install the Cisco CRS Engine, all the Datastore components, and Microsoft 
SQL Server 2000 on the server that will be the standby server before you 
reboot the server.

4. Activate all the components on the Standby server

Guidelines for Deploying High Availability with Four Servers

If you are deploying high availability in an environment with four servers, 
perform the general steps that are described in this section. Choose the method 
that suits your requirements.

Note If servers have different hard disk sizes, use the server with smaller disks 
as active servers and use the servers with the larger disks as the standby 
servers.
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Method 1: Bring up a Call Center Quickly and Add High Availability Later

If you want to bring up your call center quickly, perform the following general 
steps in order shown. With this method, Cisco CRS starts without high availability 
and you add standby servers later.

1. Install the Cisco CRS Engine on the server that will be the active Engine 
server and activate the Cisco CRS Engine.

2. Install all Datastore components and Microsoft SQL Server 2000 on the 
server that will be the active database server before you reboot the server.

3. Activate the Datastore components on the active database server.

4. Install the Cisco CRS Engine on the server that will be the standby Engine 
server and activate the Cisco CRS Engine.

5. Install all Datastore components and Microsoft SQL Server 2000 on the 
server that will be the standby database server before you reboot the server.

6. Activate the Datastore components on the standby database server.

Method 2: Bring up a Call Center with High Availability Running

1. If you want to bring up your call center with high availability running, 
perform the following general steps in order shown. With this method, Cisco 
CRS starts with high availability, but the deployment takes longer than 
method 1.

2. Install the Cisco CRS Engine on the server that will be the active Engine 
server and activate the Cisco CRS Engine.

3. Install the Cisco CRS Engine on the server that will be the standby Engine 
server and activate the Cisco CRS Engine.

4. Install all Datastore components and Microsoft SQL Server 2000 on the 
server that will be the active database server before you reboot the server, then 
activate the database components on this server.

5. Install all Datastore components and Microsoft SQL Server 2000 on the 
server that will be the standby database server before you reboot the server, 
then activate the database components on this server.
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Guidelines for Deploying Microsoft SQL Server 2000 with High Availability

When you deploy high availability, the following guidelines apply to Microsoft 
SQL Server 2000:

 • Microsoft SQL Server 2000 must be installed on each server on which the 
Cisco CRS Datastore components are installed and activated. In a four-server 
deployment, it does not need to be installed on the servers on which the Cisco 
CRS Engine is installed.

 • Complete the installation of MS SQL Server 2000 on a server before 
installing it on another server.

 • Activate the Datastore components on a server after you install MS SQL 
Server 2000 on the server.

 • If you are changing from a deployment without high availability to a 
deployment with high availability, first install MS SQL Server 2000 and 
configure the Datastore components on an existing server. Then install MS 
SQL Server 2000 and configure the Datastore components on the standby 
server.

The following update applies to the “Upgrading Cisco CRS 3.x to Cisco CRS 
4.0(5) in a Single-Server Deployment” Chapter in Cisco CRS Installation Guide:

 • In the “Upgrading Cisco CRS section, the message shown in Step 20 should 
include the text “select server_name or IP address as the data destination 
server” instead of “select server_name as the data destination server.”

 • In the “Patching Cisco CRS” chapter, add this note:

Running BARS using terminal services or VNC is not supported.
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Documentation Updates for Cisco CRS Historical Reports User 
Guide

The following change applies to the “The hrcConfig.ini Configuration File” 
section in Cisco CRS Historical Reports User Guide:

To change the defaultExportPath parameter in the hrcConfig.ini configuration file 
for the Cisco CRS Historical Reports Client, follow these guidelines:

 • Make sure that the new directory exists on the shared drive.

 • Enclose the new path in quotation marks. For example:

defaultExportPath=“\\209.165.200.225\F$\CRS_REPORTS”

Documentation Updates for Cisco Customer Response Solutions 
Historical Reporting Administrator and Developer Guide

This section includes these updates to Cisco Customer Response Solutions 
Historical Reporting Administrator and Developer Guide:

 • Updates to “Historical Reports Query Designs” Chapter, page 53

 • Updates to “Creating Custom Historical Reports for Cisco Customer 
Response Solutions” Chapter, page 54

 • Updates “Frequently Asked Questions” Chapter, page 65

Updates to “Historical Reports Query Designs” Chapter

The description of the Total Incoming Calls field in the “Traffic Analysis Report” 
section in the “Historical Reports Query Designs” chapter should say:

For each day, count the number of CCD records with a unique sessionID with the 
contactType field set to any value.
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Updates to “Creating Custom Historical Reports for Cisco Customer Response 
Solutions” Chapter

The following changes apply to the “Creating Custom Historical Reports for 
Cisco Customer Response Solutions” chapter:

 • New Section: “Before you Begin”, page 54—This new subsection should be 
the first one in the “Creating a Report” section

 • Revised Section: “Creating a Report using Crystal Reports Version 8.5”, 
page 56—This new subsection and “Creating a Report using Crystal Reports 
Version 10” replace the “Creating a Report” section.

 • Revised Section: “Creating a Report using Crystal Reports Version 10”, 
page 60—This new subsection and “Creating a Report using Crystal Reports 
Version 8.5” replace the “Creating a Report” section.

New Section: “Before you Begin”

This new sub-section should be the first one in the “Creating a Report” section.

Before you create a new report, perform these steps:

 • Write a SQL stored procedure to join database tables and calculate the data 
that the report requires. Refer to Cisco Customer Response Solutions 
Database Schema for information about the Cisco CRS database tables.

 • Copy the following files from the Cisco CRS Historical Reports folder on the 
Cisco CRS Historical Reports client system to the C:\Program Files\ 
Seagate Software\Crystal Reports 85 or to the C:\Program Files\ 
Crystal Decisions\Crystal Reports 10 folder:

 – Cal.dll

 – Cal.ini

 – CiscoAppsReports_*.dll

 – hrcConfig.ini

 – launchHRC.exe
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 • Create a shortcut to crw32.exe. The crw32.exe file resides in the same folder 
to which you copied the files above. Then right-click the shortcut, choose 
Properties, and enter the following text in the Target field. (Make sure to 
include the quotation marks.)

 – For Crystal Reports version 8.5: “C:\Program Files\Seagate 
Software\Crystal Reports\launchHRC.exe” crw32.exe

 – For Crystal Reports version 10: “C:\Program Files\Crystal 
Decisions\Crystal Reports 10\launchHRC.exe” crw32.exe

You must use this shortcut when you start Crystal Reports as described in the 
“Creating a Report using Crystal Reports Version 8.5” section.

 • From the Windows Control Panel:

a. Choose Administrative Tools > Data Sources (ODBC).

b. In the ODBC Data Source Administrator window, click the System DSN 
tab, and then click Add.

c. In the Create New Data Source window, choose SQL Server from the 
Name list and click Finish.

d. In the Create New Data Source to SQL Server window:

- In the Name field, enter a name for the data source.

- In the Server field, enter the host name or the IP address of the server 
that stores the reporting data and the reporting stored procedures. You 
must append the named instance to the server name. For example, if the 
server name is CRAHRSRV, and the named instance is \CRSSQL, enter 
CRAHRSRV\CRSSQL in this field.

- Click Next.

e. In the Create a New Data Source to SQL Server window, make sure that 
the With Windows NT authentication using the network login ID 
radio button is selected, and then click Client Configuration.

f. In the Add Network Library Configuration window:

- In the Network libraries pane, click the TCP/IP radio button.

- In the Connection parameters pane, uncheck the Dynamically 
determine port check box.

- In the Port number field, enter 4433.

- Click OK.
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g. In the Create a New Data Source to SQL Server window:

- Uncheck this check box: Connect to SQL Server to obtain default 
settings for the additional configuration options.

- Click Next.

h. Click Next and Finish as needed to exit the windows.

Note If you choose to test the data source, the system will display an error 
message.

Revised Section: “Creating a Report using Crystal Reports Version 8.5”

Refer to this section if you are creating a new report using Crystal Reports version 8.5

This section describes how to create a new report using Crystal Reports version 
8.5 For instructions about how to create a report using Crystal reports version 10, 
see the “Creating a Report Using Crystal Reports Version 10” section.

To create a new report, use Crystal Reports version 8.5 Professional or Developer 
Edition, a generally available third-party application, to create two versions of the 
report. The versions should be identical, except that one version should contain 
charts.

Tip Build the report with charts first and save it with the appropriate name for a report 
with charts as explained in Step 12. Then, delete the charts and save the modified 
report with the appropriate name for a report without charts as explained in 
Step 12.

For more information about creating reports with Crystal Reports, refer to your 
Crystal Reports documentation. For information about the tables and records in 
the Cisco CRS database, refer to Cisco Customer Response Solutions Database 
Schema.

To create a new report using Crystal Reports version 8.5, perform the following 
procedure. Make sure to follow the steps that are described in the “Before you 
Begin” section before you perform this procedure.
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Procedure

Step 1 Use the shortcut that you created as described in the “Before you Begin” section 
to start Crystal Reports, and then choose File > New.

The Welcome to Crystal Reports window appears.

Step 2 In the Welcome to Crystal Reports window, click the Using the Report Expert 
radio button and then click OK.

The Crystal Reports Gallery window appears.

Step 3 In the Crystal Reports Gallery window make sure that Standard is highlighted in 
the Choose an Expert area, and then click OK.

The Standard Report Expert window appears.

Step 4 In the Standard Report Expert window:

a. Click Database in the Data tab.

b. Click Next.

The Data Explorer window appear.

Step 5 In the Data Explorer window:

a. Expand More Data Sources.

b. Expand Active Data.

c. Click Active Data (ADO).

d. Click Add.

The Select Data Source window appears.

Step 6 In the Select Data Source window:

a. Click the ODBC (ADO) radio button.

b. From the ODBC (ADO) drop-down list, choose the name of the data source 
(DSN) that you created as described in the “Before you Begin” section.

c. Click OK.

The Data Explorer window appears.
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Step 7 In the Data Explorer window:

a. Click ado under the name of the data source (DSN) that you created.

b. Click Add.

The Select Recordset window appears.

Step 8 In the Select Recordset window:

a. Click the SQL radio button.

b. Enter the command to execute the stored procedure that you created as 
described in the “Before you Begin” section.

c. Click OK.

Step 9 In Data Explorer window, click Close.

Step 10 In the Standard Report Expert window, click the Fields tab and verify that the 
fields written by your stored procedure appear in the Available Fields list.

Step 11 Follow the directions in your Crystal Reports documentation to complete setting 
up the report.

Step 12 Save the report in the following directory under the directory in which you 
installed the client system. (By default, the client system installs in the Program 
Files directory.) Replace Language with the name of the appropriate language 
directory.

Cisco CRS Historical Reports\ Report Templates\Language

Name the report as follows:

Category_ReportDisplayName_ReportFormat_Locale.rpt

Replace Category, ReportDisplayName, ReportFormat, and Locale with 
appropriate values as explained in Table 6.
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Table 6 File Name Components 

Component Explanation Valid Values

Category Cisco CRS application package with 
which to associate this report. Users 
with access to this package will be able 
to generate this report.

CCR—IPCC Express Enhanced or 
IPCC Express Premium

ICD—IPCC Express Standard

IVR—IP IVR

ReportDisplayName You can use any name. This name will 
be replaced with the name specified by 
vFileName in the reports catalog file 
line that you add for this report.

If a name has more than one word, 
separate each word with an 
underscore.

—

ReportFormat Whether the report includes charts. Chart—Report includes charts

Table—Report does not include charts

Locale Locale ISO string. Specifies the 
language in which you created the field 
names, headings, and other static items 
in the report. Consists of an ISO 
language code followed by an 
underscore (_) and then an ISO 
country code.

Languages installed on the Cisco CRS 
Historical Reports client system. For 
example:

en_US—English

de_DE—German

es_ES—Spanish

fr_FR—French

it_IT—Italian

ja_JP—Japanese

zh_CN—Simplified Chinese

To see the languages installed on the 
client system, look at the folder names 
in the Cisco CRS Historical Reports\ 
Report Templates directory.
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The following is an example of a report name:

CCR_My_New_Report_Chart_en_us.rpt

In this example:

 • Users who have access to the Cisco IPCC Express Enhanced application 
package will be able to generate this report.

 • The report will appear as My New Report in the Report Type drop-down list 
on the Cisco CRS Historical Reports main window.

 • The report includes one or more charts.

 • The report is designed to run on a system with a system locale of English.

 • The extension .rpt indicates that this file is a report file.

Now you are ready to create a report definition file as described the “Creating a 
Report Definition File” section.

Revised Section: “Creating a Report using Crystal Reports Version 10”

Refer to this section if you are creating a new report using Crystal Reports version 10

This section describes how to create a new report using Crystal Reports version 
10 For instructions about how to create a report using Crystal reports version 8.5, 
see the “Creating a Report using Crystal Reports Version 8.5” section.

To create a new report, use Crystal Reports version 10 Professional or Developer 
Edition, a generally available third-party application, to create two versions of the 
report. The versions should be identical, except that one version should contain 
charts.

Tip Build the report with charts first and save it with the appropriate name for a report 
with charts as explained in Step 14. Then, delete the charts and save the modified 
report with the appropriate name for a report without charts as explained in 
Step 14.

For more information about creating reports with Crystal Reports, refer to your 
Crystal Reports documentation. For information about the tables and records in 
the Cisco CRS database, refer to Cisco Customer Response Solutions Database 
Schema.
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To create a new report using Crystal Reports version 10, perform the following 
procedure. Make sure to follow the steps that are described in the “Before you 
Begin” section before you perform this procedure.

Procedure

Step 1 Use the shortcut that you created as described in the “Before you Begin” section 
to start Crystal Reports and choose File > New.

The Welcome to Crystal Reports window appears.

Step 2 In the Welcome to Crystal Reports window, click the Using the Report Wizard 
radio button and then click OK.

The Crystal Reports Gallery window appears.

Step 3 In the Crystal Reports Gallery window make sure that Standard is highlighted in 
the Choose a Wizard area, and then click OK.

The Standard Report Creation Wizard window appears.

Step 4 In the Standard Report Creation Wizard available Data Sources pane, take either 
of these actions:

 • If Crystal Reports is installed on a computer that belongs to a domain, expand 
Create New Connection, and then click ODBC (RDO).

The Data Source Selection window appears.

Continue to Step 5.

 • If Crystal Reports is installed on a computer that belongs to a workgroup, go 
to Step 7.

Step 5 In the Data Source Selection window:

a. From the Data Source Name list, chose the data source that you created as 
described in the “Before you Begin” section.

b. Click Next.

The Connection Information window appears.
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Step 6 In the Connection Information window:

a. Check the Trusted Connection check box.

b. Click Finish.

Step 7 In the Standard Report Creation Wizard Data window, expand OLE DB (ADO).

The OLE DB (ADO) window for selecting an OLD DB Provider window appears.

Step 8 In the OLE DB (ADO) window for selecting an OLD DB Provider:

a. Click Microsoft OLE DB Provider for SQL Server to highlight it.

b. Click Next.

Step 9 In the OLE DB (ADO) window for providing connection information:

a. In the Server field, enter the host name or the IP address of the server that 
stores the reporting data and the reporting stored procedures.

You must append the named instance to the server name. For example, if the 
server name is CRAHRSRV, and the named instance is \CRSSQL, enter 
CRAHRSRV\CRSSQL in this field.

b. In the Database field, choose the database that contains the reporting stored 
procedures.

c. Check the Integrated Security check box.

d. Click Next.

Step 10 In the OLE DB (ADO) window for providing advanced information:

a. Change values, if needed.

Refer to your Crystal Reports documentation for more information.

b. Click Finish.

Step 11 In the Standard Report Creation Data window for choosing data:

a. In the Available Data Sources pane, navigate to and expand the Stored 
Procedures for the database that you created as described in the “Before you 
Begin” section.

b. Click the stored procedure that you want to use.

c. Click Next
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Step 12 In the Enter Parameter Values window:

a. Specifying the input parameter values that you want.

b. Click OK.

Step 13 Follow the directions provided by the Crystal Reports wizard to complete setting 
up the report.

Refer to your Crystal Reports documentation for more information.

Step 14 Save the report in the following directory under the directory in which you 
installed the client system. (By default, the client system installs in the Program 
Files directory.) Replace Language with the name of the appropriate language 
directory.

Cisco CRS Historical Reports\ Report Templates\Language

Name the report as follows:

Category_ReportDisplayName_ReportFormat_Locale.rpt

Replace Category, ReportDisplayName, ReportFormat, and Locale with 
appropriate values as explained in Table 7.

Table 7 File Name Components 

Component Explanation Valid Values

Category Cisco CRS application package with 
which to associate this report. Users 
with access to this package will be able 
to generate this report.

CCR—IPCC Express Enhanced or 
IPCC Express Premium

ICD—IPCC Express Standard

IVR—IP IVR

ReportDisplayName You can use any name. This name will 
be replaced with the name specified by 
vFileName in the reports catalog file 
line that you add for this report.

If a name has more than one word, 
separate each word with an 
underscore.

—
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The following is an example of a report name:

CCR_My_New_Report_Chart_en_us.rpt

In this example:

 • Users who have access to the Cisco IPCC Express Enhanced application 
package will be able to generate this report.

 • The report will appear as My New Report in the Report Type drop-down list 
on the Cisco CRS Historical Reports main window.

 • The report includes one or more charts.

 • The report is designed to run on a system with a system locale of English.

 • The extension .rpt indicates that this file is a report file.

ReportFormat Whether the report includes charts. Chart—Report includes charts

Table—Report does not include charts

Locale Locale ISO string. Specifies the 
language in which you created the field 
names, headings, and other static items 
in the report. Consists of an ISO 
language code followed by an 
underscore (_) and then an ISO 
country code.

Languages installed on the Cisco CRS 
Historical Reports client system. For 
example:

en_US—English

de_DE—German

es_ES—Spanish

fr_FR—French

it_IT—Italian

ja_JP—Japanese

zh_CN—Simplified Chinese

To see the languages installed on the 
client system, look at the folder names 
in the Cisco CRS Historical Reports\ 
Report Templates directory.

Table 7 File Name Components (continued)

Component Explanation Valid Values
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Now you are ready to create a report definition file as described the “Creating a 
Report Definition File” section.

Updates “Frequently Asked Questions” Chapter

The following changes apply to the “Frequently Asked Questions” chapter in 
Cisco CRS Historical Reports User Guide:

 • Question - What does it mean when the contact disposition is 3? 
Answer - When the system cleans up a call, which may have remained in the 
system because of missing events, the system writes a CCDR with the contact 
disposition dont_care (value = 3).

 • In the following scenarios, more than one record can have the same Node ID, 
Session ID, and Sequence No:

 – A call is conferenced to a CTI route point

 – A call goes RNA (ring no answer) to an agent.

 • The following steps replace the current Step 4 through Step 8 in the answer 
to “Is there a way to report on menu choices?”:

New Step 4: Define a Menu step that has three branches and place a Set 
Enterprise Call Info step in each branch.

New Step 5: In the General tab of the Set Enterprise Call Info step, click Add.

New Step 6: In the branch for caller-choice 1, enter 1 in the Value field, and 
choose Call.PeripheralVariable1 from the Name drop-down list.

New Step 7: In the branch for caller-choice 2, enter 2 in the Value field, and 
choose Call.PeripheralVariable2 from the Name drop-down list.

New Step 8: In the branch for caller-choice 3, enter 3 in the Value field, and 
choose Call.PeripheralVariable3 from the Name drop-down list.

 • The following note applies to the answer to “How can a report on reason codes 
be generated?”:

Not Ready codes are system wide and you cannot configure it to be hidden 
from certain agents.
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Documentation Updates for Cisco CRS Scripting and 
Development Series

The following information applies to Cisco CRS Scripting and Development 
Series documents:

About Expressions and Java Licensing

In CRS 4.x, Java expressions are validated against installed licenses to make sure 
that they do not violate license agreements. This validation is performed by the 
CRS Engine whenever a script is loaded or whenever a prompt template or 
grammar template is accessed and evaluated. 

In IP IVR, IP Queue Manager, IPCC Express Enhanced, and IPCC Express 
Premium, you can enter both simple and complex expressions.

However, in IPCC Express Standard, you can enter only simple expressions unless 
you also have a Java license. You automatically have a Java license with the other 
four CRS products.

An example of a TTS feature is a TTS prompt complex literal. A Java feature is a 
complex expression block, a Java-like statement, method, constructor invocation 
expression, or a field access expression. 

Any license violation will be recorded in the logs and prevent the scripts from 
being loaded in memory.

Documentation Updates for Cisco CRS Scripting and 
Development Series: Volume 1, Getting Started with Scripts

 • Cisco CRS Scripting and Development Series: Volume 1, Getting Started with 
Scripts describes the “com.cisco.dtmf.termlength” property. However, Cisco 
CRS does not support this property.

 • The following information applies when you use the Place Call Step as 
described in the “Working with Multiple Contacts” chapter:

If the RNA timeout in the script is longer than the CFNA timer of Cisco 
CallManager, the agent phone goes to Not Ready state after a ring-no-answer. 
To resolve this issue, change the timeout value in the script to a lower than 
the CFNA in Cisco CallManager.
66
Release Notes for Cisco Customer Response Solutions 4.0(5/5a)



Documentation Updates
 • The following information applies to the description of the Call Redirect Step 
in the “Designing an IP IVR Scrip” chapter:

Adding a 2 second delay is a best practice when you have a script that 
performs a a transfer or redirect to another script. Without the delay, there 
will be a timing issue. When a transfer or redirect occurs, a call leg is 
initiated. If the transfer or redirect completes and then another transfer or 
redirect occurs, the call leg from the second transfer or redirect can get stuck. 
In this case, the second transfer or redirect fails. Adding a delay ensures that 
the second transfer or redirect leg can complete before continuing through the 
script.

 • The following information applies in a Cisco CRS deployment with high 
availability when you develop a script that references XML applications:

The XML files must be stored on both the active and the standby server and 
in the same location (path name and folder name) on each server. The XML 
files are not automatically replicated between servers. Any changes must be 
made to the files on both servers. Alternatively, you may use the Document 
Management utility, which does provide replication between servers when 
the servers are synchronized.

Documentation Updates for Cisco CRS Scripting and 
Development Series: Volume 2, CRS Editor Step Reference Guide

You should not pass more than 40 characters in a call variable that is used in the 
Set Enterprise Call Info step because the database in which the call variables are 
stored limits the length of the call variables to 40 characters each. 

Though the number of characters that you can pass in a custom call variable of the 
Set Enterprise Call Info Step is unlimited, if you include more than 40 characters, 
the extra characters are lost when the variables are stored in the database, In this 
case, reports will not contain that additional information.
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Documentation Updates for Cisco Customer Response Solutions 
Servicing and Troubleshooting Guide

The following new Step 11 should be added to the “General Troubleshooting 
Steps” section in the “Diagnosing and Correcting Cisco CRS Problems” chapter:

Step 11. Verify that there is network connectivity to the CRA server.

Documentation Updates for Cisco Customer Response Solutions 
Servicing and Troubleshooting Guide

 • The following new Step 11 should be added to the “General Troubleshooting 
Steps” section in the “Diagnosing and Correcting Cisco CRS Problems” 
chapter:

Step 11. Verify that there is network connectivity to the CRA server.

 • The following note should be added to the “JTAPI subsystem is in partial 
service” troubleshooting tip:

If a failure occurs during JTAPI migration process from CRS 3.5, a CTI port 
group may have only a subset of the CTI ports migrated. This situation can 
result in JTAPI subsystem being in partial service. In this case, go to the 
JTAPI Subsystem Configuration page in Cisco CRS Administration, then 
delete and recreate the CTI port group.

 • The “Calling party and CRA do not have common codec” in the “CRA Engine 
Problems” section should include this message as a symptom:

CTIERR_REDIRECT_CALL_MEDIA_CONNECTION_FAILED=0x8ccc0036

 • The following section should be added to the “Cisco CRS Administration 
Problems” section:

Callers hear a fast busy while calling the JTAPI triggers

Symptom: While calling the JTAPI triggers, callers hear a fast busy and the 
following message appears in the MIVR log: 

%MIVR-SS_TEL-7-UNK:Call.rejected(TRIGGER_MAX_SESSION)
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Recommended Action:

1. Delete and then add back the trigger.

2. Restart CRS node manager.

 • The following information applies to the “CRS Engine Problems” section:

It is normal for the following CRS subsystems to be in Partial service if the 
subsystems are not configured. They will only be in service if you have 
configured the server to use them.

 – Database subsystem—In service only if you have configured an external 
database for something such as a database dip when a call come in.

 – MRCP ASR subsystem—In service only if you have configured an 
automatic speech recognition (ASR) system for use with Cisco CRS.

 – MRCP TTS subsystem—In service only if you have configured a text to 
speech (TTS) system for use with Cisco CRS.

 – VOIP Monitor subsystem—In service only if you have completely 
configured monitoring and recording on your server for monitoring and 
recording of agents.

Obtaining Documentation, Obtaining Support, and 
Security Guidelines

For information about obtaining documentation, obtaining support, providing 
documentation feedback, security guidelines, and recommended aliases and 
general Cisco documents, see the monthly What’s New in Cisco Product 
Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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